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Lesson 3
Checking out MPLAB-X
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In this lesson, we will assemble a short MPLAB-X program to validate that the installation is working
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1. Project Folder
1.1. Introduction
Before we can start to write programs, it's handy to set up a folder where we can keep our project
information.

1.2. Constraints on folders
As we experiment with the PIC we would like a way to keep our projects organized. I like to have a
Projects folder for all my projects, so that the entire projects folder can be quickly and easily backed up.
It's also nice to have several categories of projects. It might be nice to have a PIC projects folder, a
SPICE projects folder, and so on. Within each of those we may want to have several further categories.
However, as we play with various ham related software, we often find ourselves using software which
wasn't developed with the latest and greatest of development software. Software developed by hams may
not have been developed or tested with the ordinary user in mind. Indeed, even the MPLAB IDE has some
constraints that, while perfectly acceptable for developers, might not be obvious to ordinary users.
When developing a folder structure for these kinds of projects, the following rules should be followed:
• The entire path length should be kept below 51 characters. Fewer characters will give you more
flexibility in file names
• The entire path should consist of folders with names 8 characters or less
• The entire path should contain no blanks
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A Warning to XP users
Personally, my laptop has a folder tree like:

C:\Projects
\PIC
\Lesson1
\Lesson2
...
\SPICE
...

This allows me to keep files organized while avoiding long path names that could cause me problems with
some software.

1.3. A Warning to XP users
In Windows XP, the default is for documents to be placed in "My Documents". In general, this will not work
with MPLAB. "My Documents" is preceded by C:\Documents and Settings\(username)\. The result is that,
depending on the length of your user name, you are left with only a few characters to use beneath My
Documents.
Further, depending on your configuration, you may need to adjust the privileges on the folder you create.
Be sure you have complete privileges to the project folder.

1.4. Windows 10
Windows 10 does not have the limitations on path length, and by default, puts your documents in a
location that contains no spaces in the path (assuming your user name has no spaces).

Figure 1. Windows 10 Default Path
As a result, the default path that MPLAB-X uses should be fine. Depending on the user name, and the
sub-folders you create, it could get too long for some programs you might use with MPLAB-X, but in
almost all cases, the default is acceptable.

2. Setting Up a Project
2.1. Introduction
Before we can assemble a program, we need to set up a Project. This is an MPLAB construct that collects
all the various files that are associated with a particular PIC program.

2.2. Launch MPLAB-X
If you have chosen to have the MPLAB-X icon on your desktop, you can launch the IDE by double-clicking
that icon.
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Figure 2. MPLAB-X Desktop Icon
Alternatively, scroll down to Microchip in the All Programs portion of the start menu, click the little arrow
to the right to expand the list, and select the MPLAB-X IDE from there.

Figure 3. Windows 10 Menu
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Create the Project
When MPLAB-X is first launched, the opening window is quite busy.

Figure 4. MPLAB-X Opening Window
Much of what is there is interesting, but for now it is best we ignore it.

2.3. Create the Project
The project can be created by selecting New Project... from the File menu.

Figure 5. Creating a new project
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But it is simpler to simply click on the New Project tool bar button.

Figure 6. New Project Toolbar Button

2.4. Selecting the Project Type
Starting a new project will launch the Choose Project dialog. We will always want to choose Standalone
Project until after Lesson 20.

Figure 7. Selecting the type of project
After highlighting Standalone Project, click the Next > button.

2.5. Selecting the PIC
You will now be shown the Select device panel. The upper drop down will limit the choices in the lower to
a single family of PICs. Unfortunately, there are still plenty of choices within a single family.
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Selecting the PIC
You could select Mid-Range 8-bit MCUs (PIC10/12/16/MCP) in the upper box, then scroll through the
choices in the lower.

Figure 8. Selecting the type of PIC
But it tends to be far quicker to just type in the PIC of choice in the lower box, or at least enough
characters that the list is very short. Then click on the appropriate choice.

Figure 9. Selecting the type of PIC - partial name typed in
Select PIC16F628A and click Next >.
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2.6. Select Header
Depending on the particular PIC, you may be presented with the Select Header dialog.

Figure 10. Selecting the header

This panel may not appear
This panel is used to select a debugging header. Some PICs have debug capability built in, some
don't. Some have partial capability. Whether or not you see this panel will depend on the PIC you
have selected.
Click Next >.
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Select Programming Tool

2.7. Select Programming Tool
MPLAB-X supports a number of tools for programming PICs. For our initial lessons, we will be using the
Simulator.

Figure 11. Selecting the programming tool
In later lessons we will want the PICkit2.
When a hardware tool is installed, it's serial number shows up under the type of tool. In Figure 11,
“Selecting the programming tool”, the serial number for the PIC-EL III shows as OlHoss. You can doubleclick this serial number and replace it with a "friendly name" such as PIC-EL III.

Figure 12. Friendly names instead of serial numbers
OlHoss is a perfectly fine name for the PIC-EL, but Microchip tools tend to have serial numbers like
JIT144920788 or BUR123460589 which are decidedly less friendly.
Highlight Simulator and click Next >.
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2.8. Select Compiler
MPLAB-X supports a large number of compilers and assemblers. If you have just installed MPLAB-X and
nothing else, your only choice on this dialog will be the right one, mpasm.

Figure 13. Selecting the assembler
If you had installed some additional assemblers or compilers there may be other choices here, but the one
you want is the most recent version of mpasm listed.
Highlight mpasm and click Next >.
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Select Project Name

2.9. Select Project Name
You must now select the project name and location. If you are using Windows 10, chances are the default
Project Location: will be OK. But if you are using something else, check out Section 1, “Project Folder”
and make a selection in the Project Location: box by clicking Browse... and navigating to the desired
location.

Figure 14. Selecting the project name and location
Enter your desired project name in the Project Name: field and click Finish.

3. Adding a file to the project
At this point, there are no files in the project. We must now create a source file to use.

Only one file per project
Through the first dozen or so lessons, we will be using absolute mode. MPLAB-X will only assemble
in absolute mode if there is a single file in the project. In earlier versions of MPLAB-X you may
have to do some additional settings, but in MPLAB-X 3.45 and later, simply having a single file and
using some absolute instructions is enough for MPLAB-X to realize that you want to do an absolute
assembly.
In later lessons we will explain why you may want something different, but for now we will stick to
absolute assembly.
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Your empty project window should now look something like Figure 15, “Newly created project”

Figure 15. Newly created project
Right-click on Source Files, roll over New, and click Other....

Figure 16. Selecting the file type
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Adding a file to the project
Highlight Assembler, Select AssemblyFile.asm and click Next >.

Figure 17. Creating a new assembly file
Finally, choose a name for the file and click Finish.

Figure 18. Naming the source file
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Only required first time
This process is only required the first time. In the future, the assembly file will already appear in the
New file type menu..

At this point the window should look similar to Figure 19, “The MPLAB-X window”.

Figure 19. The MPLAB-X window

4. Entering the program
4.1. Introduction
Before we can test whether the assembler works, we need to have a program to assemble. In this section,
we will enter a program.

4.2. Entering Text
The assembler recognizes 3 columns. The columns are separated by any number and combination of
spaces and tabs. Generally, it's more convenient to use tabs as this make it easier to keep the columns
lined up. The assembler really doesn't care about that, but it's nice for us humans.
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Entering Text
Type in:

<tab><tab>processor<tab>16f628a<enter>

It should look like:

Figure 20. First line of the program
The IDE helps us along by color coding things that it recognizes. In this case, it recognized the word
processor as an assembler directive, and coded it blue. The processor directive informs the
assembler that this code is targeted at the 16f628a. Now it knows things like the memory size, number of
timers, etc.
Now add:

include<tab><tab><p16f628a.inc><enter>

This tells the assembler to include a file which contains definitions for the various assets of the 16f628a.
This, in turn, allows us to do things like reference port A as PORTA rather than H'05'.
Notice that the editor started the next line right under the word processor. In assembler, almost
everything we type will be in the second column. If we want to put something in the first column, which we
will from time to time, we can either backspace to the first column or click there.
Finally, let's add:

__config<tab>_HS_OSC & _WDT_OFF & _PWRTE_ON<enter>end<enter>

(Notice 2 underbars before config). Our program should look like:

Figure 21. First program
Almost every program we write will include these four lines, or lines very similar. Click on the save
all button (The File/Project Toolbar) or select File -> Save to save the program. Also notice that the
assembler directives (and opcodes) are colored blue. If you type in a directive and it isn't blue, you
probably have a typo.
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5. Assembling the Program
5.1. Introduction
Remember way back in Lesson 1 we said that an assembler converts text that we can (more or less) read
into binary data for the computer? Well, now we are about to do that.

5.2. Assembling
To perform the assembly, we can select Clean and Build from the Project context (right click) menu:

Figure 22. Project context menu
Or we can click on the Clean and Build Main Project toolbar button:

Figure 23. Clean and build main project toolbar button
The results will display in a new pane that will open below the source code panel. With a little luck, the
pane will say BUILD SUCCESSFUL in green.

5.3. What if I did something wrong?
Of course, there's a possibility that we had a typo or something. The assembler, of course, will tell us. Just
to see this behavior, try changing the word include to something else, say, diversify.
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So What Did That Mean
Assemble the program and see:

Figure 24. Assembler Errors
Wow, there's a lot of stuff there.
First of all, once the assembler sees one error, it can get pretty confused. In this case, it wasn't even an
error at all, just a warning 'Found label after column 1.'. What's it thinking?
Well, sometimes you need to get yourself into the assembler's head. It found the word 'diversify', and it
knew it was neither an instruction nor a directive. If it's neither of those, it must be a label. But it didn't start
in column one like all good labels should, so it warned us about that typo.
Well now, the next thing after a label should be an instruction. But the '<' character isn't allowed in an
instruction, so it flags it as an illegal character. Now things just go from bad to worse.
Whenever you are debugging a program, always start with the first message first. There's a good chance
that the later messages, even if they are on different lines, are a result of the first.
In this case, the next 4 errors are on line 3. The 4 symbols were never defined! Well, no, because
we never read the include file, the assembler didn't know when we said diversify we really meant
include. So a long, scary-looking list of errors comes down to one simple typo.

6. So What Did That Mean
6.1. Introduction
We wrote and assembled a little program with four lines, but we never really explained what most of those
lines meant. We'll skip processor, because we already talked about that one.

6.2. include
The include directive tells the assembler to read another file as if it were typed into the current file.
Within the directory we installed MPLAB, there is a folder containing a number of these files, and that
is where the assembler looks first. The most common use for an include file is to describe a number of
constants. In this case, there are a pile of constants defined in p16f628a.inc, and they are used frequently.
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They include, as we mentioned earlier, things like the addresses of some of the special registers and the
values of various bits in the configuration word (see below) and other special registers.

6.3. end
The end directive is pretty simple. It simply marks the end of the source file.

6.4. __config
The __config directive is the most interesting of those we have entered so far. The PIC has a
configuration word that sets various behaviors, and the __config directive sets the value for that
configuration word.
Each bit in the configuration word has a special meaning. The '&' character between the various symbols
we entered does a bitwise AND operation between the various symbols. The symbols are defined such
that we can AND them in order to set the right combination of features into the configuration word.
_HS_OSC set the bits to use the high speed crystal oscillator. Other choices were _XT_OSC (crystal
oscillator), _LP_OSC (low power crystal oscillator), and _RC_OSC (RC oscillator). The first three require a
crystal installed (as we have on the PIC-EL), the difference being the speed of the crystal, and hence the
amount of excitation current required. The fourth presumes we have set the processor clock speed with an
external resistor and capacitor.
_WDT_OFF sets the watchdog timer off. The processor contains a timer that can interrupt us every so
often, or cause us to wake up if we have put the processor to sleep. Normally we don't use this feature,
but if we did, we would set this value to _WDT_ON.
_PWRTE_ON told the processor that we want the power up timer enabled. This basically prevents the PIC
from executing any instructions until 72 milliseconds have gone by. This gives our external circuitry a
chance to stabilize before our program actually starts. We could have said _PWRTE_OFF if we wanted to
be Johnny-on-the- spot when the power came up.
The final symbol in our configuration was _LVP_OFF. The PIC16F628A and a number of other PICs from
that time period have a feature called 'low voltage programming'. That feature tends to cause confusing
issues and has been dropped from newer models. To avoid that confusion, and since we are not using it,
we will turn that feature off.

7. The MPLAB-X User Interface
7.1. Introduction
MPLAB-X is actually a high-end development environment called NetBeans, which has been tailored for
the PIC. As a professional development environment, it is very feature rich. Many of those features will
come in handy, but many aren't very relevant for assembler development.

7.2. Panes
One of the first things you notice is that the window is divided into a number of panes. These panes all
can be resized by dragging their borders, and even rearranged. To avoid confusion, though, it is better
not to rearrange them. Resizing, however, is almost necessary since not everyone has the same size or
resolution of screen.
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Panes

Upper left pane
The upper left pane contains a Projects tab, which is an overview of the parts of your project. By default,
it shows a logical view. For absolute assembly this isn't terribly useful, but it will become more interesting
later. You may have several projects open, and this tab allows you to select between projects.
The upper left pane also includes a Files tab. This shows you the files in your project. While there is only
one source file, there are a number of other files, some of which can be interesting.
The next tab (by default) in the upper left pane is Classes which is pretty uninteresting, and may be
deleted by selecting the tab, then clicking on the tiny X in the upper right of the tab.

Figure 25. Classes tab

Tabs can be recovered
Any tab you close can be brought back by selecting the tab from the Window menu.

Lower Left Pane
By default, the lower left pane contains the Dashboard and Navigator tabs.
The Dashboard tab contains details about your project. Of particular interest, to the left are a number
of toolbar buttons. Clicking on the Project Properties button (top one, looks like a wrench, nut and bolt)
takes you to the properties dialog, where you can change most of the settings you made when you set up
the project.

Figure 26. Dashboard tab
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The lower left pane also contains the Navigator tab, which is useless for absolute assembly development
and can be closed like the Classes tab.

Figure 27. Navigator tab

Upper Right Pane
We have already seen the upper right pane, which is usually the largest, is where your source file shows
and where you edit the source. There is also a Start Page tab, which we saw when we first launched
MPLAB-X. As we do more work, the Start Page tab will also include a list of recent projects.
When a source file is selected, beneath the tab are two buttons; ASM Source and History. Clicking on
History will show a list of times when you have saved the source. Clicking on one of these times will show
what changed between saves.

Figure 28. History View
Whenever you build your project, MPLAB-X automatically saves everything. However, because of this
feature it is useful to save frequently beween builds.
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Nothing stays the same

Lower Right Pane
We have already seen how the assembler output shows in the lower right pane.

Figure 29. Lower Right Pane
However, this pane can be quite dynamic. As we will see in the next lesson, lots of tabs and sub-tabs can
appear in this pane, depending on what we are doing.

7.3. Nothing stays the same
We have seen how every pane might have multiple tabs. We have also seen how we can remove and add
tabs. We can also re-order tabs by simply grabbing the tab and dragging it.

Figure 30. Dragging a tab
We can even drag a tab to a new pane, make an entirely new pane, or even drag the tab to an entirely
new window. When we are dragging, the new location will show with an orange outline (Figure 30,
“Dragging a tab”). Sometimes these more extreme customizations are useful, but to avoid confusion, it is
best to avoid getting too carried away.
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7.4. The main project and the toolbar
In the example, there was only one project open. However, you might have multiple projects open. If one
project is identified as the "Main Project", the project name is bold.

Figure 31. Multiple projects open
In Figure 31, “Multiple projects open”, writeEEPROM is the main project. You can make a project the main
project from the project's context (right click) menu.
Near the top of the window are toolbars. In general, the toolbars apply to the main project. Everything that
can be done with the toolbar can also be done from the project's context menu.
Like everything else, the toolbars may be dragged around, so you can change their order, move them to
multiple lines of tools, etc. Items on the toolbar will be grayed if they are not relevant at the current time.
The debugging toolbar will only appear during debugging.
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The main project and the toolbar

The File/Project Toolbar
The file and project toolbar does things that are common to many programs; open projects, create new
files or projects, undo and redo previous operations, etc.

Figure 32. File and project toolbar

The Device Toolbar
The device toolbar contains buttons for downloading your program into the PIC, reading the PIC, releasing
the PIC from reset so the program can run, and starting the debugger.

Figure 33. Device Toolbar
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The Debugging Toolbar
The debugging toolbar only appears when you are debugging. It allows you to step through instructions,
step over subroutines, etc. Debugging with PIC16 parts and with the PIC-EL III is very limited, so this is
mostly useful when you are using the simulator. It can be very helpful when you are using more advanced
PICs and the ICD-3 or PICkit 3 debugger.

Figure 34. Debugging toolbar

8. Wrap Up
8.1. Summary
In this lesson, we entered a small program into the IDE. The program actually did nothing, but it was a
program. We assembled it, and even inserted an error so we could see the assembler's behavior when we
got an error. Finally, we talked about what each of the four lines do.

8.2. Coming Up
In the next lesson, we will explore many of the PIC instructions, and start to get an understanding of how
we use the file registers and the working register.
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